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Knowledge Bases (KBases) 

Q1. What are Knowledge Bases? 

A1. A Knowledge Base is a set of parameter values, based on actual project, requirement, and 

environment data similar to your estimating scenario, which can be used to initialize values in your WBS 

elements. Knowledge bases can be customized to reflect your organization's development history, 

environment, and requirements. 

 

Q2. Why should I use Knowledge Bases? 

A2. Knowledge bases allow you to create rough order of magnitude (ROM) estimates with only a few 

high level inputs. The Knowledge Bases were created from statistics gathered from a wide variety of 

industries, companies and government databases; therefore they allow you to create an estimate based 

on the best known industry standards and metrics. 

In addition, Knowledge Bases: 

 Represent a dramatic time decrease in estimate generation 

 Improve accuracy (if models are properly validated) 

 Provide a mechanism to tune the models 

 Provide greater credibility in front of customers/management 

 Allow more time to focus on engineering effort 

 

Q3. What types of Knowledge Bases are provided in SEER SEM? 

A3. SEM provides different Knowledge Bases depending on the type of WBS element being estimated. 

The following Knowledge Bases are provided:  

For Program, Component and Unit WBS Elements: 

- Platform: Describe the primary mission or operating environment of the software under 

estimation (e.g. Business, Client-Server, ERP Development) 

- Application: Describe the primary function of the software (e.g. Communications, Data Mining ) 

- Acquisition Method: Describe the scope and type of project being developed or maintained. 

These Knowledge Bases generally apply to rework of preexisting functions or source lines of 

code and are used to estimate the effort associated with the various scenarios described. (e.g. 

New Development, Requirements Only, System Testing Only) 

- Development Method: Describe the method to be used for the development of the software 

(e.g. Agile, RUP, Waterfall)  
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- Development Standard: Describe the standards to be followed during development. These 

Knowledge Bases generally include values for the specification level, test level, and quality 

assurance level parameters (e.g. Commercial, IEEE, DO-178B) 

- Class: User customized Knowledge Bases 

 

For Commercial Off-The-Shelf (COTS) WBS Elements: 

 

- Platform: Same as above. 

- Application: Same as above 

- Component Type: Describe the type of COTS component (e.g. Database, Legacy Program, Stand 

Alone Application) 

- Test Rigor: Correspond to the Development Standard of traditionally developed software, 

except that COTS elements are not developed, only tested. In fact, the Knowledge Bases in this 

category have the same names and definitions as Development Standard Knowledge Bases, 

since they describe the same quality control levels. 

 

Q4. How do I apply Knowledge Bases? 

A4. Knowledge Bases are applied when the WBS Element is first created, in the Create/Modify WBS 

Element window.  

 

Q5. How do I change Knowledge Bases on an existing WBS Element? 

A5. There are two ways of changing Knowledge Bases for an element:  

1. Double click on the element which will open up the Create/Modify WBS Element window. Click 

on the Change button near the lower right corner. This will allow you to then change the 

Knowledge Bases. NOTE: By changing Knowledge Bases in this manner, all Knowledge bases will 

be re-loaded for the selected WBS Element. You will lose any parameter settings you have 

entered. 

2. Select the WBS Element by clicking on it in the Project WBS window. Go to menu Estimate and 

select Load Individual Knowledge Base... option. This will allow you to change one Knowledge 

Base at a time, without re-loading all of them. Also, this method allows you to not overwrite 

parameter values the user has put in. 

 

Q6. What is the effect of adding multiple Knowledge Bases to a WBS Element? 

A6. Each Knowledge Base is a collection of predefined values for the parameters in SEER. Knowledge 

Bases are applied in the order they appear in the Create/Modify WBS Element window. Each applied 
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Knowledge Base takes precedence over the one applied previously; therefore it may override some 

parameter values (e.g. Platform Knowledge Bases are loaded first, so they have the lowest precedence. 

Class Knowledge Bases are loaded last so they have the highest precedence and may override values set 

by previous Knowledge Bases). A Knowledge Base may not have values specified for a particular 

parameter, in which case the parameter will not be overwritten. 

 

Q7. How do I know what parameters are being affected by a Knowledge Base? 

A7. Knowledge Bases contain data to initialize your parameter values based on historical and best 

industry metrics. It is often useful to determine what parameters are being affected by a Knowledge 

base. To do this, two approaches can be used: 

 Open the SEER-SEM help and type in “Knowledge Base Allocation Table”. This will bring a table 

that shows how the parameters are affected by each Knowledge Base category.  

 Turn on the Knowledge Base Audit Trial option inside the Tools menu. This option keeps a 

detailed log of which parameters are set by Knowledge Bases. When it is on (checked), it creates 

a detailed log file named “Kbase Audit Trail.txt” (in the default project file directory) which 

records the parameter changes, with new entries appended to the end. 

 

Q8. My Knowledge Bases lists are empty? 

A8. SEER-SEM will look for the Knowledge Bases in the directory specified in the Set Paths… option 

under the Options menu. By default, the path is set to the Knowledge Bases folder in the SEER 

installation directory. If you are creating a new WBS element and the dropdown menus for the 

Knowledge Bases are empty, make sure to check the path to ensure it is set correctly.  Also, notice that if 

you have created you own Knowledge Bases, these will not show unless they are saved in the directory 

specified in the Set Paths…option. 

 

Q9. How can I perform Trade-off analysis with multiple Knowledge Bases? 

A9. To perform a Trade-off analysis of the results obtained with two different Knowledge Bases, start by 

selecting the WBS Element that will be subject to the analysis. Set a reference by selecting the option 

Set Reference under the menu Estimate. This will set a reference of the estimate with the currently 

loaded Knowledge Bases. Now change the Knowledge Base using the Load Individual Knowledge Base… 

option from the Estimate menu (Refer to Q5 inside Knowledge Bases). Observe the differences in the 

estimate in the Quick Estimate report. Also, the Inputs vs. Reference report will show a detailed list of 

the parameters that changed when the new Knowledge Base was loaded. After the analysis, it is 

possible to go back to the original estimate by selecting the option Revert to Reference from the menu 

Estimate. 
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Q10. Why can’t I change the Platform Knowledge Base using the Load Individual Knowledge Base 

option? 

A10. The Platform Knowledge Base contains settings for all parameters. As a result, if a Platform 

Knowledge Base is loaded individually, it will overwrite the settings done by all the other Knowledge 

Bases. The result would be a WBS element that only contains parameter settings for the selected 

platform Knowledge Base, even though it has more Knowledge Bases associated to it. To avoid this from 

happening, the loading of an individual platform Knowledge Base has been disabled in the Load 

Individual Knowledge Base… option. The only way to change the Platform Knowledge Base is from the 

Create/Modify WBS Element window. However, this method will load all Knowledge Bases and 

overwrite any parameter settings done by the user. 

Q11. How are Knowledge Bases maintained by Galorath? 

A11. Knowledge Bases are kept under continuous maintenance and improvement at Galorath. New 

Knowledge Bases are created and existing ones are updated based on Industry trends. When new or 

updated Knowledge Bases become available, they are included with the next major release of SEER-SEM 
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WBS  Elements 

Q1. What are WBS Elements? 

A1. A WBS Element is each of the single entities that constitute the Work Breakdown structure of the 

estimate being generated. The total project effort is calculated by adding the effort of each of its WBS 

Elements. 

 

Q2. What types of WBS Elements are provided in SEER-SEM? 

A2. SEER-SEM provides the following types of WBS Elements: 

- Rollup: represents an aggregate summary of its subordinate WBS elements. Rollups are typically 

used to organize and quantify meaningful subsets or parts of the project. 

- Application: An aggregation of computer software which satisfies an end-use function and is 

designated for configuration management. 

- Component: A component of a program. a Component represents an effective-size subset of its 

parent Program. 

- Unit: A Unit represents an effective-size subset of its parent Component 

- COTS: A Commercial Off-The-Shelf (COTS) Element is an element that represents an already 

developed collection of software. 

 

Q3. Can I change the element type for an existing WBS element? 

A3. No you cannot. You may remove the existing WBS Element and create it again. 

 

Q4. How can I make copies of individual or multiple WBS elements? 

A4. To copy an individual WBS element, highlight the desired element and either right click and select 

copy, go to Menu Edit => Copy, or Ctrl+C to copy. To add the element to a project you would then use 

the Insert Paste command from either the Edit menu or from right clicking on the Project WBS window. 

NOTE: Copying multiple WBS elements is currently not supported in SEER-SEM. It is possible to export the 

commands for a Rollup WBS and its subordinates and then run those commands to reproduce an exact 

copy. To do this, follow these steps: 

1) Select the Rollup WBS Element you want to copy 

2) Under the menu Tools, select the option Export Commands 

3) In the Export Commands window, select Current WBS Element Plus Subordinates, Output to 

clipboard, and then mark the KBase and Parameters boxes. 

4) Click the Export button 
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5) To paste the copied elements, under the menu Tools select the option Run Commands from 

Clipboard. 

NOTE: The approach described above can be used to copy WBS Elements across multiple instances of 

SEER-SEM. It may also be used to copy an entire project and replicate it in another instance of SEER-

SEM.  

Q5. How do I exclude an element from the rollup costs without removing it? 

A5. This can be accomplished by the either right clicking the element and selecting Exclude Element 

From Rollups/Totals, selecting the element and clicking Exclude Element From Rollups/Totals under the 

menu Estimate, or by highlighting the element and clicking the Exclude Element From Rollups/Totals 

button ( ) on the toolbar. 

 

Q6. How do I arrange WBS Elements? 

A6. First select the WBS Element you want to arrange. 

Then you can use the buttons in the tool bar:  Promotes a WBS Element,  Demotes a WBS 

Element,  Move WBS Element Up and   Move WBS Element Down 

Or you can select the options under Arrange WBS Element Commands in the Edit Menu. 

 

Q7. How do I change the outline number for an element? 

A7. You can do so by re-arranging the WBS Element (See Q6 under WBS Elements). The base outline 

number may be modified by selecting the option Set Project Parameters… from the Options menu. 

Enter the desired base outline number in the Project Outline Start Number field and click the OK 

button. 

 

Q8. How do I place an element into a rollup? 

A8. This is done similarly to arranging WBS Elements (Q6 under WBS Elements). Use the Move WBS 

Element Up/Down buttons to position the element under the rollup. Then click the Demote WBS 

Element ( ) button to move the element into the rollup. To move an element out of a rollup, click 

the Promote WBS Element ( ) button. You can also click and drag an element into a rollup. 
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Q9. How do I perform risk analysis at a rollup element or project level? 

A9. First you must click Enable Rollup Risk Calculation under the Options menu. Then select the desired 

Rollup element or the Project Rollup and just press F9 or click the Calculate Now ( ) button on the 

toolbar. The total number of Monte Carlo iterations may be modified by selecting the option Set Project 

Parameters… from the Options menu. Enter the desired number of iterations in the Rollup Risk 

Iterations field and click the OK button. 

 

Q10. Why can’t I insert a COTS Element in my estimate? 

A10. This can be caused by two possible reasons: 

1) COTS components are sub-components to a Program WBS element.  First create an element of 

type Program and then insert the COTS element underneath it. 

Note:  If the Program WBS element already contains a size value then the application will 

prompt you to first insert a Component WBS element to hold the sizing information and then 

you will be allowed to enter a COTS element.  Once a Program Item has one sub-component all 

size values must be allocated to the sub-components. 

NOTE:  If the Volume Inputs option of the Project Rollup WBS Element has been set to Lines only, 

then any added COTS elements will be ignored (their costs and schedule will not be considered in the 

total estimate). To correct this, select the Project level WBS element and double click on it. In the 

Create/Modify WBS Element window click the button Change located in the lower right corner. 

Select either Both or Functions for the Volume Inputs option and click OK. 

 

  



SEER-SEM Frequently Asked Questions  P a g e  | 13 

 

 
 

Parameters 

Q1. What are SEER-SEM Parameters? 

A1. As the name implies a “Parametric Model” consists of a set of parameter settings that reflect things 

such as Technology, People, Process, Program schedule and staffing constraints, etc. Parameters are the 

inputs for the SEER-SEM parametric estimation model. Parameters are processed using Cost Estimation 

Relationships (CERs) in order to generate software estimates. 

 

Q2. What type of parameter settings can be specified in SEER-SEM? 

A2. SEER-SEM allows you to specify the parameter settings for the following groups of parameters: 

- Sizing Parameters: Used to size the software being estimated. Three sizing methods are 

available in SEER-SEM: Source Lines of Code, Functions and Proxies. 

- Technology and Environment Parameters: Define aspects that influence the estimate, such as: 

personnel experience and capabilities, technology complexity, resource availability, 

environment limitations, etc. 

- COTS Parameters: Standard parameters that apply to Commercial-Off-The-Shelf (COTS) 

elements. 

- Other Parameters: Other parameters not related neither to size nor technology and 

environment (e.g. schedule, confidence levels, economic factors) 

Q3. Which parameters carry the most weight for estimates? 

A3. Size parameters carry the most weight in the estimate. No matter what your sizing method is 

(Source Lines of Code, Functions and Proxies), the effort required to create the software varies 

proportionally with its size. Technology and Environment Parameters also have different weights on the 

estimate, as illustrated in the following figure: 
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Q4. What is Proxy Sizing? 

A4. Proxies are customized systems of measure for software size; you can create your own proxies, or 
use SEER-SEM's built-in proxies. A proxy can be based on anything which can be counted, and which 
roughly corresponds to your project's development effort and schedule. SEER-SEM converts proxy input 
to standard units, using established conversion factors. For example, if you know that an application's 
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size corresponds to the number of screens, you can create a proxy named Screens, which will convert 
the screen count into function points. 
 
Q5. How do I edit parameters? 

A5. Parameters can be edited by selecting them in the Inputs window and double-clicking. A window will 

appear that will let you change the value of the parameter. Typically, you will be able to edit the Least, 

Likely and Most values for each parameter.   

Q6. Can I change parameters over multiple elements? 

A6. Yes. You can do this by going to the Edit menu and clicking on Change Parameters in Multiple WBS 

Elements…. This will open up a window with the list of parameters. Find and double click on the desired 

parameter to open the editing window, and then edit the parameter values. Do this for each parameter 

you want to change in multiple WBS elements. Once you have finished editing the desired parameters 

click on the Next> button. In the screen that appears select the WBS elements where you want the 

changes to be applied. Finally click on the Finish button. 

 

Q7. Is there a way to observe the effects of parameter changes in an element to see how costs will 

change without modifying the element? 

A7. Yes. Select the element you wish to look at and go to the menu Estimate and select Set Reference. 

You can also click the Set Reference button ( ) on the tool bar. This will expand the Quick Estimate 

report to display the original referenced estimate, the changed estimate and a percentage of difference 

between these two. When you are finished changing parameters you can select one of the following 

options from the Edit menu: 

 Set Reference to commit the changes and set a new reference (Note: You will not be able to 

revert the changes) 

 Revert to Reference to undo the changes back to the reference values 

 Clear Reference to remove the reference and keep the modified values 

NOTE: The reference column stays in place for any element’s Quick Estimate window. This can be useful if 

you wish to compare two separate elements.   

 

Q8. Some parameters are bolded or in different colors, what do these mean? 

A8. By default, parameters are shown in blue. However, certain settings can make a parameter show in 

a different color: 

 Bolded – Parameter has been changed from the Knowledge Base default by the user 
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 <<Green>> – Parameter value is linked. It is being set indirectly from another source, such as 

another WBS Element or an external source, such as an Excel file. 

NOTE: Default color for the parameters and links can be changed in the Font…  and Linked Parameter 

Color…  options, respectively, under the View menu. 

 

Q9. What is meant by Least/Likely/Most in a parameter? 

A9. When estimating software, it is often not possible to predict an exact value (unless the project is 
finished and you have access to the actual values). The Least, Likely, and Most fields in a parameter 
allow the user to express risk in the estimate by allocating uncertainty ranges. SEER-SEM converts Least, 
Likely, Most inputs into probability distributions, which it uses to produce estimates with ranges of 
possible outcomes. Least corresponds to the lowest value that is expected, Likely is the most probable 
expected value, and Most the highest expected value for a parameter. 
 

Q10. I put in values in a Least/Likely/Most parameter and SEER rearranged them. What happened? 

A10. If this is happening it is because there is an inconsistency with the values you have entered. As a 

general rule: Least ≤ Likely ≤ Most. SEER will automatically assign the lowest value to the Least field and 

the highest value to the Most field. 

 

Q11. Why do I see different parameters for different WBS Elements? 

A11. Different parameters will be available depending on the type of WBS element you are selecting. 

SEER-SEM will only display the parameters applicable to the WBS Element being selected. For example a 

COTS element has a separate set of parameters than does a Component element. 

 

Q12. No parameters are shown when I select a Rollup or Project WBS Element. Why is this happening? 

A12. SEER-SEM allows setting unique parameters to the different WBS elements under the Rollup (e.g. 

two programs under the same Rollup may be developed by different teams and have different 

technologies, therefore needing different parameter settings). When working with Rollup WBS 

elements, parameters should be set at the lower level WBS Element and therefore they are not available 

at the Rollup level.  

 

Q13. Can I Copy and Paste parameter values from one WBS Element to another one? 

A13. Yes you can. Select the WBS Element where you want the values to be copied from. Highlight the 

parameter(s) you want to copy (Hold the Ctrl key to select several parameters, or the Shift key to select 
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a range) then go to the Edit Menu and select Copy (you can also press Ctrl+C). Now select the 

destination WBS Element where you want the values to be copied and go to the Edit Menu and select 

Paste (or click Ctrl+V). 

Q14. How does the Minimum Time vs Optimal Effort parameter work? 

A14. This parameter is used to choose between optimizing the schedule or optimizing the effort in the 

estimate. Optimizing for schedule (minimum time) assumes the development will be finished as quickly 

as possible. Staff will be added as quickly as possible, but larger teams will reduce efficiency, and, 

although the project will be completed sooner, it will cost more. Optimizing for effort assumes the 

software will be developed in as economical a fashion as possible, but will take longer to complete. 

Staffing will be lower and thus smaller; more efficient teams will realize a cost savings. 

 

Q15. What is the Function Implementation Mechanism (FIM) parameter and how does it affect my 

estimate? 

A15. This parameter is the language or implementation mechanism, such as a code generator or screen 

generator, that will be used to build the current piece of software. This parameter is of particular 

interest when estimating using Function Based Sizing. The parameter affects the equivalent size, or 

amount of effort required, to implement a function (e.g. it is not the same building 100 screens in C than 

building the same 100 screens using a screen generator. The amount of effort will be higher in C). When 

estimating using Lines of Code, the parameter is used to adjust the effort (some low level languages 

such as Assembly will require more effort to deliver the same functionality) and also to estimate defect 

prediction.  If you enter a number of lines of code and then change the FIM you will be asked if you want 

to convert the entered size, based on what is known about how languages map in terms of volume 

against one another. If you click Change, you will be asking SEER-SEM to migrate the original size and 

express it in SLOC for the new language selected. If you just want to change the language and keep the 

same SLOC size (e.g. you selected an incorrect language), then click No. 

This parameter is closely related to the Language Type parameter. If either of these two parameters is 

changed, the other should be checked to ensure that they are consistent. For example, if the Function 

Implementation Mechanism is changed from SQL to C, Language Type should also be changed from 

Low to Nominal, since SQL is a 4GL and C is a 3GL. 

 

Q16. Why can’t I see the Estimate to Complete parameters? 

A16. Estimate to Complete (ETC) parameters are used to project completion based on how much 

progress has been made (expressed as how much is yet to be completed). If the Project Monitor & 

Control (PMC) option is turned on, it replaces the ETC capability by allowing the user to track project 

completion using traditional Performance Management Methods. Both features cannot be used 

concurrently so SEER SEM disables one method when the other one is enabled. The ETC Parameters and 
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the Estimate to Complete report are disabled when the PMC mode is enabled. To enable ETC , disable 

PMC by unselecting the option Project Monitor & Control under the menu Project Monitor & Control. 

 

Q17. Does SEER-SEM provide Earned Value analysis? 

A17. Yes, SEER-SEM offers the Project Monitor & Control (PMC) feature to measure project 
completion and forecasting using the standard Earned Value method. Project Monitor & Control is a 
unique tool in that in addition to tracking progress to date, it also tracks defect discovery and removal 
and artifact completion. 

 
Q18. How should I use the Programs Included in Size and the Programs Concurrently Integrating 

parameters? 

A18. The Programs Included in Size parameter corresponds to the number of complete stand-alone 
programs which make up a WBS element (For Agile projects this can represent a sprint). The default 
setting is always 1. The parameter can be used to estimate an entire project as a single WBS element. 
For example, if you wanted to estimate 3 Programs as a single WBS element, enter the total functions 
or lines of code for all 3 Programs in a single WBS element, and set this parameter to 3. When the 
parameter is over 1, the Program WBS element icon in the Project WBS window will change to a 

“multi-program” icon ( ). 

The Programs Concurrently Integrating parameter corresponds to the number of other stand-alone 
computer programs that need to be integrated with the program that you are analyzing. If all three 
inputs are set to 0, then no software-to-software integration is included in your estimate. 

 
Q19. Does SEER allow me to account for cultural, political or geographical differences within my 

development team (Multi-cultural team)? 

A19. The Multiple Site Development parameter can be used for this purpose. The parameter can be 
used to rate the organizational and site diversity among the personnel developing the software. This 
separation can be due to physical location, political boundaries, or even security. Consider anything 
that would isolate one part of the development team from another. SEER-SEM help for this 
parameter offers additional guidelines. 

 

Q20. How to link a parameter(s) between MS Excel and SEER-SEM? 

A20. To link a parameter between MS Excel and SEER-SEM follow these steps: 

 

To paste data from SEER-SEM as a link to Excel: 
1) In SEER-SEM, select the parameter(s), right click and select Copy. This will copy the parameter(s) 

with the correct syntax and format for the link. 

2) In the Excel spreadsheet, select the cell where you want to place the source of the link and paste 

the data using the Paste Special option Paste Link. 

 

file:///C:/Program%20Files%20(x86)/SEER/SEER-SEM%208.0/Help/wbs_element.htm
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To create a link from Excel to SEER-SEM: 
1) In the Excel spreadsheet, ensure all data is selected and copy it. This can be done by pressing 

Ctrl+C or selecting the Copy option from the menu. 

2) In SEER-SEM, select the WBS element where you want to paste the linked object, go to the 

menu Edit and select the option Paste Special….  

3) In the Paste Special window select the option Paste Link and click the OK button. 

The linked parameter should change to green and enclosed in << >>.  

The SEER-SEM help provides additional documentation on Linking Objects. Type in the keyword “link” to 

retrieve the information. 

 

Q21. Is there a way to adjust the level of documentation required for a project? 

A21. Yes, this can be done by adjusting the Specification Level – Reliability parameter. This 
parameter reflects the level of specification documentation needed (which is also an indicator of the 
level of reliability required) for the project. The parameter allows choosing the documentation level, 
from no documentation at all (parameter set to Very Low) to Highest Reliability, which implies a high 
level of documentation and formality and assumes that all documentation is delivered to the 
customer (parameter set to Very High). 

NOTE: SEER SEM also allows adjusting the level of Testing (V&V) and Quality Assurance, using the 
parameters Test Level and Quality Assurance Level respectively. 
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Reports and Charts 

Q1. What reports are available in SEER-SEM? 

A1. SEER-SEM provides the following reports: 

- PMC Report 
- Activity Report 
- Basic Estimate Report 
- Calibration Summary Report 
- Cost by Fiscal Year Report 
- Cost By Labor Category Report 
- Cost By Month Report 
- Cover Sheet Report 
- Detailed Staffing Profile Report 
- Estimate To Complete Report 
- FBS Inputs Report 
- FBS Inputs vs. Reference Report 
- FBS Inputs with Notes Report 
- Inputs Report 

- Inputs vs. Knowledge Base Report 
- Inputs vs. Reference Report 
- Inputs with Notes Report 
- Labor Category Allocation Report 
- Maintenance Effort by Year Report 
- Person Hours By Labor Category Report 
- Person Months By Labor Category 

Report 
- Rollup Development Risk Report 
- Rollup Schedule Risk Report 
- Quick Estimate Report 
- Risk Analysis Report 
- Software Metrics Report 
- Time-Phased Defects Report 

 

Q2. What charts are available in SEER-SEM? 

A2. SEER-SEM provides the following charts: 

- Activity Allocation 
- Annual Expenditure 
- Benchmark vs. Kbase Risk 
- Cost Risk 
- Defect Profile 
- Defects Risk 
- Defects Sensitivity 
- Effort Comparison 
- Effort Risk 
- Effort Sensitivity 
- Effort/Schedule Trade-Off 
- Estimate Assessment 
- Estimate vs Kbase 
- Goals Confidence Level 
- Labor Category Allocation 
- Maintenance Allocation 

- Maintenance by Fiscal Year 
- Maintenance Cost Risk Chart 
- PMC Benchmark 
- PMC Defects Tracking 
- PMC Health & Status Indicator 
- PMC Performance Indices 
- PMC Schedule Accomplishments 
- Project Gantt 
- Schedule Comparison 
- Schedule Risk 
- Schedule Sensitivity 
- Size Allocation 
- Staff Level vs Reference 
- Staffing Plan 
- Technology Assessment 
- Top 10 Effort Impacts 

 

Q3. How do I select which reports/charts appear in the window? 

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);


SEER-SEM Frequently Asked Questions  P a g e  | 21 

 

 
 

A3. Right click anywhere on the Report/Chart window and select the option Choose Active 

Reports/Charts…. In the window that appears you can define which reports will appear in the 

Reports/Charts window.  

 

Q4. How should the risk chart be used? 

A4. The risk chart presents the probability of successfully attaining various outcomes of cost and 

schedule through line charts. The percentages along the x axis of the chart are the probabilities of the 

project succeeding at the estimated figures. For example, if the probability is 30% there is a 30% chance 

that the actual project would be under the estimated schedule and cost figures. 

 

Q5. How do I get the risk analysis charts at a rollup element or project level? 

A5. First go to the menu Options and ensure that the Enable Rollup Risk Calculation option is selected. 

Then Press F9 or push the Calculate Now  ( ) button. 

 

Q6. How can I change what details are shown in the quick estimate report? 

A6. Go to the Estimate menu and select the option Quick Estimate Options…. Similarly, you can right 

click the report windows and select Quick Estimate Options…. 

 

Q7. I changed the probability parameter but the risk chart didn’t change, why is that? 

A7. The risk chart represents the probability distribution for a given output (Cost, schedule or defects; 

depending on the rick chart). Changing the probability parameter will not result in a change to the curve, 

but instead it will select a different point on the curve, representing the probability or confidence level 

of the current estimate. When changing the probability parameters the risk curve will not change but 

the blue dot ( ) will move to reflect the confidence level of the current estimate. 

 

Q8. Can I export a Report? 

A8. Yes you can. Right click anywhere on the Reports window and select the option Export Report. In 

the Export Report window you can change the following settings: 

- Select to export data for the Current WBS Element only, Current WBS Element and Subordinates 

or for the Entire Project. 



SEER-SEM Frequently Asked Questions  P a g e  | 22 

 

 
 

- Select the Reports you want to export 

- Preview the report before it is exported 

After you have entered your settings, click the Choose Format button. Select the format and the 

destination for the report and then click the OK button. In the window that appears select location 

where you want the report to be saved and click the Save button. 

Q9. Can I export a Chart? 

A9. Yes you can. Right click anywhere on the Charts window and select the option Copy. Go to the 

application where you want to copy the Chart and Paste it. Some applications will have different 

commands to paste data, but most of them are compatible with the Ctrl+V command.  

 Q10. Why is there a difference between the Productivity Lines/Person Month in the Quick Estimate 

report and a simple calculation dividing Total Lines/Development Effort Months? 

A10. The reported productivity in the Quick Estimate report does not include the effort for all 

activities.  See definition below from the help: 

Productivity 

Lines/Person 

Month 

The number of lines of code estimated to be developed per person month of effort 

during the design through Program testing activities, also known as the FSI or Full 

Scale Implementation activity. This productivity excludes any software requirements 

activities. 

When you are looking at productivity in SEER-SEM, it is best to use the Software Metrics report.  At the 

bottom of the report, you will see a table of productivity measures for the different combinations of 

activities and labor categories included in the calculation. Look for the metric that says All under the 

Activity column and this metric should match the simple calculation. 

 

Q11. Why can’t I see the notes in my Flexible Export report? 

A11. This is likely to be caused by an option not being set in the Options tab of the Flexible Export 
dialog. In the Options tab, check the Output By selection.  Notes can only be exported if the Output By 
option is set to Rows and the Include Parameter Notes option is checked.  When the format is set to 
Columns, you will notice the Include Parameter Notes option is grayed out because it is not supported. 
NOTE: If you want to export the WBS Element notes, be sure to include WBS Element Description in the 
Selected Choices list of data to export.  WBS Element Notes are associated with this item. 
  

Q12. Why can’t I see the Least/Likely/Most values in my Flexible Export report? 

A12. If the report was generated by columns, it will only show the Likely values. In order to see the 
Least/Likely/Most values, the report must be generated by rows. To do this, In the Options tab of the 
Flexible Export window, select the radio button Columns in the Output By options. Then click the Export 
button and the report should now include the Least/Likely/Most values. 
 

file:///D:/Rockwell%20Automation/full_scale_implementation_(fsi)_phases.htm
file:///D:/Rockwell%20Automation/full_scale_implementation_(fsi)_phases.htm
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Q13. Why don’t I see all parameters listed in the Inputs report? 

A13. The report will only display the parameters that are visible in the Parameters tab of the Inputs 

window. Any hidden or collapsed parameters will not be shown. To display the parameter in the report, 

expand the section where the parameter is in the Parameters tab. It may be required to press F9 or 

select Calculate Now from the Estimate menu to update the report. Some parameters may be hidden 

and will only show when a specific feature or mode is enabled (e.g. The ADJUSTMENT FACTORS 

parameters will only show when in calibration mode). All the input reports, with the exception of the 

Inputs vs. Reference and the FBS Inputs vs. Reference, share this same behavior. 

 

Q14. How can I tell the effect a parameter has on my estimate? 

A14. This can be done using the Sensitivity Charts. SEER-SEM offers three types of sensitivity charts: 

Effort, Schedule and Defects. The charts can be selected by clicking on the Charts window and selecting 

the option Choose Active Charts…. Select each chart my marking the corresponding checkbox. 

The sensitivity chart is updated every time you select a different parameter in the Parameters tab in the 

Inputs window. The arrow button ( ) located in the lower left corner will switch between the 

complete range of values for the parameter or just the selected Least/Likely/Most values and the Mean. 

It is possible to click on the bars of the sensitivity charts to see the resulting estimate for each value of 

the parameter. In general, all charts will show the resulting cost and schedule. The Defects Sensitivity 

chart will show in addition the amount of predicted defects. 
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General 

Q1. What’s the Database and how does it differ from just saving my files to a directory? 

A1. Using the databases allow for more functionality and reduce the chances of confusion when multiple 

users are accessing a SEER SEM estimate. There are two different types of databases employed by SEER: 

the Historical Database (HD) and the Enterprise Database (Enterprise DB).  SEER-HD is a database which 

serves as a repository (central data-storage location) for common reference data of completed 

estimates. SEER Enterprise DB allows projects to be maintained and shared across a workgroup or 

enterprise, supporting multi-user access, as well as security, archiving and version control. 

 

Q2. Why are there multiple files in my project directory? 

A2. SEER-SEM uses three different files when saving a project. They are as follows: 

1. .PRJ – Initial save or the currently saved version of the project. 

2. .PRL – Linking file for the project. This file saves the notes and links you have entered in your 

project. If this file is not present the notes and links will not be available. 

3. .BAK – Backup of the previous save. The .HBK file will only be created if two saves on the project 

have occurred.  This allows a user to go back to a previous revision of a project if the .HAR file 

has been corrupted or it is desired to revert to an earlier modification. To use the .HBK file, 

delete the existing .HAR file and then change the extension of the .HBK to .HAL. 

 

Q3. Where can I find the User’s manual and other documents that relate to SEER-SEM? 

A3. The manual and other documents can be found in the main SEER SEM installation directory (typically 

C:\Program Files\SEER\SEER-SEM 8.0). Once in the SEER SEM folder, open the Documents folder, and 

then open the Tools folder. The documents can also be found by navigating in the Windows Start Menu 

until you find the SEER For Software folder, then click on Tools. 

 

Q4. How do I get all the windows back after maximizing or resizing a chart/report window? 

A4. Go to the Window menu and select Arrange All from there. 

 

Q5. What are Labor Category Allocations? 

A5. Labor Category Allocations are inputs that let you define the percentage of work to be performed by 
each Labor Category (or role). For each lifecycle activity (Requirements Analysis, Preliminary Design, 
Code & Unit Test, etc), SEER-SEM lets you customize the amount of work performed by each labor 
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category (or role). Labor category allocations can be changed in the Labor Category Allocation tab in the 
Inputs window.  
 

Q6. Does SEER SEM consider Inflation in my estimates? 

A6. Yes it does. You can set a cost escalation factor used for inflation if you go to the menu Options and 
select Project Parameters. Enter the factor in the field Cost Escalation Factor (Note: By default SEER-
SEM will provide a value for the parameter) and then Click the OK button. In the reports, SEER-SEM will 
provide two values: Base Year Cost, which will be the unadjusted (not considering inflation) and Then 
Year Cost, which will consider the inflation factor. You can see Then Year Costs in the Cost By Fiscal Year 
Report (Refer to Q3 in Reports and Charts for instructions on selecting reports). 
 

Q7. Can I change the default Labor Rates used to compute labor costs? 

A7. Yes you can. Select the WBS Element for which you want to change the default labor rates. In the 

Parameters window, look for the heading ECONOMIC FACTORS and expand it. Then expand the heading 

AVERAGE MONTHLY LABOR RATE. Here you will be able to change the default labor rates for all 

development labor. NOTE: All rates can be changed here except by the Maintenance labor rate. The 

labor rate for maintenance is located under the heading SOFTWARE MAINTENANCE. 

 

Q8. What is Pre-existing functionality in SEER-SEM? 

A8. SEER SEM size categories include new functionality (either lines of code or functions) and two types 

of pre-existing functionality. New functionality is to be built from scratch; pre-existing functionality 

already exists, and will be reused, with some degree of modification. The pre-existing categories may 

also be used for estimating special circumstances, such as generated code and test-only activities. 

There are two categories of pre-existing functionality: designed for reuse and not designed for reuse. 

The former generally requires significantly less rework than the latter. SEER SEM allows you to specify 

the percentages of redesign, reimplementation and retest for pre-existing functionality. Click on the “+” 

next to a category's name to see its parameter list. You can use more than one size metric, but be 

careful to count each unit of software only once. 

 
Q9. How can I export data to use in other applications? 

A9. SEER-SEM offers a wide variety of output charts and reports that can be exported in the most 

common types of formats. Refer to questions Q8 and Q9 within Reports and Charts.  

In addition to this, SEER-SEM also offers the Flexible Export feature. This feature is the most versatile 

method of exporting data from SEER-SEM; it lets you create customized reports that can be exported as 

text files, copied onto the Windows clipboard, or displayed in the Reports window. You can also format 
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information for other applications, including project management tools and spreadsheets. You can 

create templates that capture any combination of SEER for Software outputs or inputs: 

 Display the outputs by rows or by columns. 

 Display outputs for a single unit, a unit and its subordinate elements, or the entire project. 

 Select a delimiter for your output (tab, comma, etc.). 
 

Several templates are included in SEER for Software; you can use them as starting points when you 

create your own. To use the Flexible Export feature, go to the Tools menu and select the Flexible 

Export… option. 

In addition to the above described exporting features, SEER-SEM is compatible with Microsoft’s 

Component Object Model (COM) interface. This allows SEER-SEM results to be exported to any other 

COM applications, such as Microsoft Office, by establishing persistent links, which allow SEER to share 

information with virtually any other type of program, including spreadsheet, slideshow, project 

planning, and word processing applications.  

Q10. What is Effective Size? 

A10. Effective Size in SEER-SEM equals the new lines of code which would be generated by the amount 

of effort required by the project. For a project with all new code, effective size equals new size. When 

the project includes preexisting code, the full formula is: 

Total Effective Size = New + Preexisting Effective Size 

The Pre-existing effective size is calculated based on the actual size of the pre-existing code and the 

rework percentages: Redesign, Reimplementation and Retest. Overall Effective Size is thus a hybrid-

normalized measure of the total amount of software to be developed. It includes all new and preexisting 

functions, lines of code, COTS functionality to be integrated, and proxy size, each adjusted for effort. If a 

project uses any preexisting code, Effective Size always will be less than or equal to total size. 

Q11. How can I tell SEER to exclude all effort related to Requirements from my estimate? 

A11. There are two equivalent approaches to remove all Requirements effort from the estimate: 

1) Setting the Requirements Definition Formality parameter to VLo (Very Low – No requirements 

analysis included in this estimate)  

2) Setting the Requirements Complete at Start parameter  to Hi and the Requirements Effort After 

Baseline parameter to NO. 

 

Q12. How should I count my SLOC? 

A12. SEER calculations assume that the SLOC count is of logical lines only. Extensive documentation can 

be obtained from the SEER-SEM help, just search for the keyword “Lines of code”, which will bring a 
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table with additional guidelines for counting logical lines of code. Additionally, a link to download a 

qualified SLOC Counting tool is available at Galorath’s web site. 

Q13. Is there a way to collect data for an estimate without having a SEER License? 

A13. Yes. The “SEER-SEM Input worksheet.xls” located in the SEER-SEM installation Tools directory can 

be used to collect data required for an estimate without having to run the SEER-SEM software. The 

spreadsheet has fields to specify all parameters, Knowledge Bases, size information and all other inputs 

required to generate an estimate in SEER-SEM. A typical use for the worksheet is to collect data from the 

Developers or Subject Matter Experts (SMEs) to develop an estimate in SEER. They do not need to have 

a license of SEER to provide their inputs if they use the worksheet. The data from the worksheet can 

then be easily imported in SEER-SEM using Server Mode and the Run Commands From Clipboard option 

in the Tools Menu. NOTE: More documentation on how to import the data from the worksheet into SEM 

is available in the actual worksheet or by typing the keyword “Server Mode” in the SEER-SEM help. 

 

Q14. How do you create a Maintenance-Only estimate in SEER SEM? 

A14. SEER-SEM allows the users to estimate the maintenance costs for their projects. In general, the 

maintenance costs are calculated along with the development costs and SEER provides separate cost 

and schedule estimates for each. However, SEER also allows the user to create a maintenance-only 

estimate. To do this, follow these instructions: 

1) Start by creating a project in SEER-SEM. Select the Knowledge Bases that better fit the 
environment of the system to be maintained. IMPORTANT: For the Acquisition Method 
Knowledge Base, make sure to select one of the Maintenance-Only Knowledge Bases (Full 
Effort/Sustaining for Mature System/New System). In the Create/Modify WBS Element window, 
you can click on the label Acquisition Method to display additional information to help you 
choose your Knowledge Base. 

2) Create a new WBS Element of type Program. This element will be used for the maintenance-only 
estimate.  Select the Knowledge Bases that better fit the environment of the system to be 
maintained. IMPORTANT: For the Acquisition Method KnowledgeBase, make sure to select one 
of the Maintenance-Only Knowledge Bases (Full Effort/Sustaining for Mature System/New 
System). In the Create/Modify WBS Element window, you can click on the label Acquisition 
Method to display additional information to help you choose your Knowledge Base. 

3) In the element you just created, enter the size of the application to be maintained. This can be 
done using either Lines of Code or Functions. What is important is that the sizing values are 
entered in the Pre-existing fields (either Designed for reuse or not designed for reuse). 

4) Specify any other parameters needed to better model the environment and the system to be 
maintained. 

5) Specify the Maintenance parameters (under the SOFTWARE MAINTENANCE Heading) to better 
fit your maintenance needs. The parameters in this section will drive the calculation of the 
maintenance effort. Make sure to select Maintenance Size = Total Size. NOTE: There were 
significant changes to the maintenance model in SEER-SEM 8.0 release, please refer to page 30 
of the “SEER-SEM 8.0 Release Notes.pdf” for more information. The PDF can be found inside the 
Tools folder in the SEER-SEM installation directory. 
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6) Observe the results of the Maintenance-Only estimate in the Quick Estimate report. The 
following reports provide additional details about the maintenance effort: Maintenance effort 
by year, Software Metrics (displays total and latent defects). The following charts display 
information about the maintenance effort: Maintenance by Fiscal Year, Maintenance 
Allocation, Annual Expenditure, and Maintenance Cost Risk. 

 

Q15. How do you create a Testing-Only estimate in SEER SEM? 

A15. In general, the costs associated with testing are embedded within the development costs. 

However, SEER allows the user to create a testing-only estimate. To do this, follow these instructions: 

1) Start by creating a project in SEER-SEM. Select the Knowledge Bases that better fit the 
environment of the system to be tested. IMPORTANT: For the Acquisition Method Knowledge 
Base, make sure to select Integrate As-Is as the Knowledge Base. 

2) Create a new WBS Element of type Program. This element will be used for the testing-only 
estimate.  Select the Knowledge Bases that better fit the environment of the system to be 
maintained. IMPORTANT: For the Acquisition Method Knowledge Base, make sure to select 
Integrate As-Is as the Knowledge Base. 

3) In the element you just created, enter the size of the application to be tested. This can be done 
using either Lines of Code or Functions. What is important is that the sizing values are entered in 
the Pre-existing fields (either Designed for reuse or not designed for reuse). 

4) Make sure to set the Requirements Complete at Start parameter to High to eliminate from the 
estimate any effort associated with requirements activities. 

5) Specify any other parameters needed to better model the environment and the system to be 
tested. The Integrate As-Is Knowledge Base sets the Redesign and Reimplementation 
percentages to 0.01% (to tell SEER not to include any effort for design or coding) and the Retest 
percentages to certain values. If the Retest percentages do not represent the effort required 
you can adjust them using one of the following approaches: 

a. Set the percentages using your best engineering judgment. 
b. Use the “SEER-SEM Rework Percentages.xls” file, found under the Tools folder in the 

SEER Installation directory, to determine the percentages and then copy the 
percentages into the SEER-SEM estimate. 

6) Observe the results of the Testing-Only estimate in the Quick Estimate report. 
NOTE: The resulting estimate will not include any effort for Unit Testing since this is assumed to be part 

of the Coding activity. In case Unit Testing effort needs to be included, the user should use the “SEER-SEM 

Rework Percentages.xls” file to calculate the Reimplementation percentage including Unit Testing and 

then copy the percentage into the SEM estimate. 

 

Q16. How can I tell SEER to exclude System Integration activities from my estimate? 

A16. To disable the System Integration, set the Programs Concurrently Integrating parameter to 0 

(Nominal, No software to software integration) and also the Hardware Integration Level parameter to 

VLo (Very Low – No Hardware Integration.) 
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Q17. How can I estimate a program with incremental builds/releases? 

A17. SEER-SEM allows modeling a program with incremental builds or releases. To accomplish this, 
follow these steps: 
 

1) Create a Program WBS element to represent the initial development. Select Knowledge Bases and 

enter parameters as necessary to better model the initial development. 

NOTE: For modeling an incremental effort, there are two possible Development Method Knowledge 

Bases that can be applicable: Incremental and Spiral. Both Knowledge Bases assume a life cycle where 

the Requirements-Design-Code-Integration sequence is repeated several times (i.e. for each build or 

increment). The difference is that the Incremental Knowledge Base assumes each iteration will yield a 

deliverable to the customer, whereas the Spiral Knowledge Base assumes each repetition will result in an 

executable subset that is suitable for demonstration and testing but that, with the exception of the final 

build, is not intended for delivery to the customer. 

2) In the Project WBS window, select the created WBS element and choose Copy from either the Edit 

menu or the right-click context menu. It is also possible to press Ctrl+C. 

3) Create a new Program WBS Element. Make sure to highlight this element by clicking on it. 

4) From the Edit menu, select the option Paste Special…. Then select Paste Build and click the OK 

button. 

NOTE: In the Paste Special window, it is also possible to select the option Insert New WBS and Paste 

Build, in which case it would not be necessary to create a new Program WBS Element to hold the next 

increment.  

New and pre-existing lines of code from the previous build become pre-existing lines of code for the 

new build. The start date for the new build will be the day after the completion date for the previous 

build. All other parameters will be unchanged. The user will have to enter any new code to be developed 

for each build. For the subsequent builds (excluding the initial development), the Acquisition Method 

Knowledge Base can be changed to Subsequent Incremental Build using the Load Individual Knowledge 

Base… option from the Estimate menu. This Knowledge Base will assume no requirements effort is 

needed after baseline and also that maintenance estimates of subsequent builds are only for the portion 

of software being added and modified in this build (Maintenance Size parameter will be set to Effective 

Size). 

IMPORTANT: It will be required to rate the amount of rework needed to integrate code from the 

previous build into the new build. Guidance to set the rework percentages for incremental builds can be 

found in the “SEER-SEM Detailed Reference.pdf”, located in the Tools folder inside the installation 

directory.  

To create subsequent builds, copy the most recent build and follow steps 3 and 4. 

If you model incremental builds as shown above, each increment should represent a delivered, 

operational program, with its own development cycle. If the increments are non-deliverables, such as 
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internal milestones, progress demonstrations, or concept prototypes, they should be modeled as a 

single development, and not broken out into individual Program WBS elements. 

 

Q18. Why can’t I open a file that was created in a different version of SEER-SEM? 

A18. This can be a consequence of some known compatibility issues between different versions of SEER-
SEM. This issue can be worked around using the Export Commands… option. To do this, follow the next 
steps: 
 
In the Original SEER-SEM Project: 

1) Under the menu Tools, select the option Export Commands. 

2) In the Export Commands window, select Entire Project, Output to File, and then mark the KBase 

and Parameters boxes. 

3) Click the Export button and save the generated commands file. 

In the Destination SEER-SEM Project: 
1) Under the menu Tools, select the option Run Commands File… 

2) Locate the commands file and select it. The project will be regenerated. 

3) Save your project file. 

Note: If going from Version 8.0 to 7.3 of SEER-SEM, it will be required to use the “SEER-SEM Backward 

Converter.xls” spreadsheet, which can be provided upon request.  

Q19. How should I model a language conversion project? 

A19. SEER-SEM allows modeling a conversion from one language to another. The conversion is assumed 
to be a migration-only effort, with none or very minimum redesign effort.  
 

1) Start by creating a new Program WBS Element and select the Knowledge Bases that better 

reflect the environment and the system. For the Acquisition Method Knowledge Base, SEER 

offers two options that can be used for modeling a language conversion: Language Conversion, 

Manual and Language Conversion, Automated. As the name implies, the former is to be used 

when the conversion is to be done manually, while the latter assumes that there is some sort of 

translation tool to perform the conversion automatically. Both Knowledge Bases assume no 

change in the software design beyond what is dictated by the language change (i.e., the original 

functionality will remain intact). The main difference between these two Knowledge Bases is in 

the Reimplementation required parameter, which is set to 100% for the manual conversion, but 

is assumed to be very low for the automated case. Also, the Retest required parameter is 

slightly higher for the manual case (since the code is manually generated, it is assumed to be a 

little more error prone). 

2) Enter the size of the original application to be converted using one of the available sizing 

methods (Lines of Code, Functions or Proxies). IMPORTANT: The size must be entered in one of 

the pre-existing fields (either designed for reuse or not designed for reuse). This should be 
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decided based on an assessment of the origin code. (E.g. if the code was developed in house, it is 

considered to be understandable and it has a good level of documentation, then it can be 

modeled as designed for reuse). Whatever the choice is, the key to an accurate conversion 

model relies on setting the correct rework percentages. Adjust the percentages as needed to 

reflect the level of redesign, reimplementation and retest required. The “SEER-SEM Rework 

Percentages.xls” spreadsheet can be used to perform a mode detailed calculation of the 

parameters. 

3) Adjust any other parameters required to better reproduce the environment, technology, 

resources, economic factors, etc. For example, changes in the SYSTEM INTEGRATION 

parameters may be required to account for difficulties integrating the new software in the 

target.    

 Q20. How should I model Commercial Off-the-Shelf (COTS) software? 

A20. SEER-SEM allows estimating the costs associated with the use of COTS. The term “Off-the-shelf” 

can refer to a wide variety of development items and as a result the approaches used for estimation are 

equally diverse. It is important to spend enough time up-front understanding and classifying the COTS 

element before it can be modeled in SEER-SEM. 

1) Understanding and classifying the COTS element: 

 

COTS element will typically follow in one of the classifications shown above. The first distinction that 

must be done is whether the COTS will be part of the end application or not. Examples of embedded 

COTS include libraries, object classes, self-contained applications and re-used code. Examples of non-

embedded COTS include compilers, code generators, integrated development environments (IDEs), 

automatic testers, requirements tools, configuration management tools, etc. 

Embedded COTS are further divided into Adapted and Component elements. Adapted COTS is typically a 

component developed for other purposes but that can be adjusted to be used in the application. This 

type of COTS is usually available as source code but requires modification (e.g. redesign, redesign and 

code, changes in interfaces, etc). 

Component COTS are integrated directly in the application. This type is usually intended for reuse and its 

source code is often not available. Some examples are: Libraries, object classes, applications, 

frameworks and graphic packages.   

2) Modeling the COTS in SEER-SEM: 

COTS 

Embedded 

Adapted Component 

Non-
embedded 

Tools 



SEER-SEM Frequently Asked Questions  P a g e  | 32 

 

 
 

Adapted COTS: This type of COTS should be modeled in SEER-SEM as reused functionality. It can be 

modeled using a Program, Component or Unit WBS Element, selecting the appropriate Knowledge 

Bases and parameters. Do not use the COTS WBS element to model this type of COTS. Estimation of 

adapted software involves a consideration of existing software reuse (lines or functions) with a 

description of the rework required, described in terms of redesign, reimplementation, and retest. The 

“SEER-SEM Rework Percentages.xls” worksheet can be used to aid in the calculation of the rework 

percentages. 

Component COTS: Components are modeled in SEER-SEM using the COTS WBS element, describing the 

functionality to be used and some other attributes of the COTS. Two Knowledge Bases categories are 

exclusive for COTS: The Component Type Knowledge Base, which describes the COTS component, and 

the Test Rigor Knowledge Base, which describes the level of formality that will be applied when testing 

the COTS Component (This category is the analog of the Development Standard Knowledge Base for 

Program WBS Elements). Additionally, three sizing options are available for COTS:  

- Quick Sizing: Approximates size by analogy with well-known commercial libraries. 

- Feature Sizing: Simplified version of the function points approach. Model functions from the 

developer’s perspective. 

- Object Sizing: For object-oriented COTS. Adapted from IFPUG's object-oriented function point 

specification. Models functions from the user’s perspective. 

Once the COTS WBS Element is created, adjust any parameters needed to model the COTS component. 

Make sure to enter any costs, recursive and non-recursive, under the COSTS parameters. 

Interfacing the Component COTS with the rest of the application usually requires the creation of some 

Glue Code. Such code should be modeled in SEER-SEM as a new development using a separate WBS 

element ( Component, Program or Unit WBS Elements can be used), and selecting the appropriate 

Knowledge Bases and parameter settings. 

Tools COTS: Tools COTS do not require a WBS element. They should be considered when rating the 

technology and environment parameters. To consider the use of such tools in the estimate, look at the 

ratings for such parameters as Automated Tool Use, Requirements Definition Formality, Function 

Implementation Mechanism, and others that relate to the development environment and processes. 

The following figure shows an example WBS for an embedded system using COTS: 

file:///C:/Program%20Files%20(x86)/SEER/SEER-SEM%208.0/Help/automated_tools_use.htm
file:///C:/Program%20Files%20(x86)/SEER/SEER-SEM%208.0/Help/requirements_definition_formality.htm
file:///C:/Program%20Files%20(x86)/SEER/SEER-SEM%208.0/Help/function_implementation_mechanism.htm
file:///C:/Program%20Files%20(x86)/SEER/SEER-SEM%208.0/Help/function_implementation_mechanism.htm
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NOTE: Additional guidelines for modeling COTS can be found in Chapter 9 of the “SEER for Software 

Detailed Reference”. This document can be found in the Tools folder of the SEER-SEM installation 

directory. 

Q21. How does SEER-SEM convert Function Points to SLOC? 

A21. SEER-SEM converts data entered as Functions, Lines of Code or Proxies into internal units called 

Effort Units. The amount of work required to deliver one effort unit is equivalent to the amount of work 

required to deliver one source line of code, in a typical 3rd generation language (Such as C). When 

estimating using Functions, the Software Metrics report shows an estimated amount of Effort Units, 

which can be approximated to the amount of source lines of code estimated for the application.  

With regards to the conversion factor from Function Points to SLOC, there are many sources in the 

literature and in the web, however, no standard has been defined and there is a lot of variability. SEER-

SEM utilizes Galorath’s proprietary conversion factors, which are obtained from historical data and best 

industry standards, to translate function points into lines of code. The following parameters affect the 

conversion:  

- Function Implementation Mechanism: Used to select the conversion factor to be applied (each 

language has a different factor). 

- Software Phase at Estimate: More effort units are estimated when the software is in the earlier 

phases. 

- Application Class Complexity: More effort units are estimated for higher complexity 

applications. 

 

Q22. Can I use SEER-SEM to estimate firmware development? 

A22. Yes it is possible. However, depending on the formality and rigorousness of the process being 

followed, it could be more suitable to model such development in SEER-H. If the firmware is being 

developed, documented, managed and configuration controlled as usually done in a software 

development project, then it can be modeled in SEER-SEM. However, if the firmware development is a 
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small portion within a hardware development, probably not following any particular standards, then it is 

recommended to model such project using SEER-H.  

If using SEER-SEM to estimate firmware, these are some things to consider: 

- Language: Is it a high level language or assembler being used? Make sure to set the Function 

Implementation Mechanism and Language Type (Complexity) parameters appropriately. 

- Target System: the embedded device and the system that will host the firmware. Rate its 

complexity, volatility and the familiarity of the development team. 

- Hardware Integration Level: how difficult will be to integrate the firmware in the hardware? Is 

the hardware being concurrently developed? Make sure to set the Hardware Integration Level 

parameter. 

- Memory, Timing and throughput constraints: typical of embedded systems. Assess the 

parameters under TARGET ENVIRONMENT to better reflect the environment.  

 

Q23. How SEER-SEM estimates compare to COCOMO II? 

A23. Estimates prepared in both tools can differ due to several reasons. Before comparing an estimate 

done in COCOMO with an estimate done in SEER, it is necessary to ensure they are the same estimate 

(i.e. apples to apples comparison). It would not be enough to just confirm that the same software 

(same functions, same size) is being estimated, but also to ensure that the equivalent parameters in 

both tools have been set consistently. For example, even though the same size is being estimated, it 

would not be valid to compare both estimates if the developer capabilities and experience have been 

assumed to be high in SEER-SEM, but were rated low in COCOMO. Galorath Incorporated has done 

extensive research on mapping the parameters in SEER-SEM to the equivalent parameters in COCOMO, 

making possible the conversion from one tool to the other one with similar results.  The outcome of 

such research has been consolidated in a paper that can be provided by Galorath upon request.  

 

Q24. What is included in the Project Manager labor category in SEER-SEM? 

A24. The Project Manager labor category includes all personnel involved with direct labor software 

management. It does not include hardware management or highest level program management. 

Direct software management refers to the people who manage development work on a day-to-day 

basis, so called “Level 1” management. Higher levels of management are managers who manage 

managers; program managers are an example of management that is not included. For all intents and 

purposes, these people are not the direct developers. 

Q25. How can I model a Spiral development? 

A25. Modeling a Spiral development is similar to modeling Incremental Builds/Releases. Refer to Q17 in 
the General section. 
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Q26. How should I model a development using a code generator? 

A26. SEER-SEM allows modeling a development using a code generator. The coding is assumed to be 
fully automated. No manual coding is required.  

1) Start by creating a new Program WBS Element and selecting the Knowledge Bases that better 

reflect the environment and the system. For the Acquisition Method Knowledge Base, select 

Code Generator. For the Development Method Knowledge Base select Code Generation. This 

set of Knowledge Bases will set the rework percentages assuming that no implementation effort 

(manual coding) will be needed, but that a high level of testing and some design will be 

required. These are the typical needs of automated code generation 

2) Estimate the size of the code to be produced using one of the available sizing methods (Lines of 

Code, Functions or Proxies). When using a code generator, it may be difficult to predict lines of 

code, therefore sizing by Functions or Proxies might be more appropriate. IMPORTANT: The size 

must be entered in one of the pre-existing fields (either designed for reuse or not designed for 

reuse). Adjust the rework percentages as needed to reflect the level of redesign, 

reimplementation and retest required. For example, the Knowledge Bases assume that no 

manual coding will be needed, but based on previous experiences with a particular code 

generator it may be required to “hack” the generated code to make adjustments. In this case, 

the Reimplementation Required parameter needs to be increased. Also, if the code generator is 

a qualified tool, the required level of testing can be dicreased by lowering the value of the Retest 

required parameter.  The “SEER-SEM Rework Percentages.xls” spreadsheet can be used to 

perform a more detailed calculation of these parameters. 

3) Adjust any other parameters required to better reproduce the environment, technology, 

resources, economic factors, etc. For example, changes in the SYSTEM INTEGRATION 

parameters may be required to account for difficulties integrating the auto-generated software 

in the target.    

Q27. The Monte Carlo Rollup reports show two columns, Independent and Dependent. What are those 

and which one should I use? 

A27. These two columns report the different correlation levels used by the Monte Carlo Sampling. 

The fully uncorrelated estimate is labeled Independent on the risk report. It implies that the WBS 

elements in your project are essentially independent of one another and the outcome of one program 

will not impact the outcome of another program. 

The fully correlated estimate is Dependent. It implies that the WBS elements in your project are very 

closely interrelated and the cost and schedule outcomes of all programs will be high if any one is high, 

and low if any one is low. 

The Monte Carlo analysis is a statistical approach used to accumulate risk at the Rollup level. Predicting 

the correlation is usually very difficult, so SEER-SEM provides the two extremes (full correlation and no 

correlation). The actual outcome will probably lie somewhere between this range. 
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Q28. Is there a way to specify a partial correlation for the Monte Carlo Analysis? 

A28. It is often difficult to determine correlation levels (partial correlation) between project elements. 

Because of this, SEER-SEM only provides full correlation (Dependent) and no correlation (Independent). 

If exploring with partial correlations is required, a possible approach is to linearly interpolate between 

the independent and dependent extremes. For example, if the independent (no correlation) and 

dependent (full correlation) outcomes for a certain probability are 10.000 and 12.000 respectively, the 

50% correlation outcome would be 11.000. A 70% correlation outcome would be linearly closer to the 

dependent value, thus resulting in 11.400. 

Q29. Are indirect labor and expenses included in my estimate? 

A29. No. Costs associated with indirect activities such as executive (corporate) management, proposal 

and preparation and administrative/clerical (G&A) work are not included in an estimate. However, they 

can be indirectly factored in by adjusting the labor rates to include a higher level of burden. The labor 

rates can be adjusted in the Parameters tab of the Inputs window, under the ECONOMIC FACTORS 

heading. There is a parameter to specify the rate of each individual labor category. Also,  a common rate 

can be applied to all labor categories using the heading parameter AVERAGE MONTHLY LABOR RATE. 

 

Q30. How do I account for effort associated with functionality to be deleted? 

A30. SEER-SEM allows specifying the amount of functionality (lines of code or functions) that is going to 

be deleted from the pre-existing code. However, no effort is associated with the deleted functionality. 

The amount of lines is just discarded before any calculation for pre-existing functionality is done. A 

possible workaround to include some effort associated with deletion of functionality is to adjust the 

Redesign required parameter. It is recommended to set a reference, by pressing the Set reference 

button ( ) or selecting the option Set Reference from the Estimate menu. This will allow checking 

the impact of the changes in the Redesign required parameter until they match the desired effort for 

the deletion. 

 

 

 


